
  
    
  
Riconciliazione



Once transactions have been entered into GnuCash, it is important to verify
      that they agree with the records of your financial institution. This
      verification process is known as reconciliation, and it is key to determine
      whether your records are accurate. Most commonly, you will check transactions
      against bank statements, although you can use this process to verify any
      transaction.
GnuCash keeps track of the reconciliation status of each
        transaction. The reconciliation status of a transaction is shown by the
        reconciliation R field in a register:
        y indicates that a transaction has been
        reconciled, n indicates that it has not, and c indicates that it has
        been cleared, but not reconciled. A split marked cleared signifies that you got some kind of confirmation
        that the institution accepted the order (e.g. you have the restaurant's receipt for your credit card purchase).
        You can toggle the reconciliation status
        between n and c by clicking in the R field; you can set 
        it to y by using la sezione chiamata «Finestre di riconciliazione».
At the bottom of the account window, there are (among others) two running
      balances (the cleared and reconciled balance), and the 
      total balance. The former balances should correspond to how much money
      the bank thinks you have in your account, while the latter includes outstanding transactions.
For example, when you write a check for something, you should
      enter the transaction into GnuCash. The reconciliation R field of the
      transaction will initially contain n (new). Your new entry will
      contribute to the total balance, but not to the cleared and
      reconciled balance. Later, if you got some confirmation that the check has been cashed,
      you might click on the transaction’s R field to change it to c
      (cleared). When you do this, the cleared balance will
      change to include this amount. When the bank statement arrives, you can
      then compare it to what you’ve recorded in GnuCash by opening the reconciliation
      window. There, you will be able to change the R field to y (reconciled).
Nota
You cannot reconcile directly in a register window by clicking in the R field. You must use the
        reconciliation window. Once a transaction has been marked reconciled,
        it can no longer be easily changed without breaking the 
        Starting Balance of the next reconciliation.

Avvertimento
It is important to understand that reconciliation is done for a given
        date, and when you reconcile an account based on a statement from a given date,
        you are reconciling all transactions prior to that date. Therefore, if you
        add or modify transactions that predate your last reconciliation, your
        reconciled balances will be thrown off.

Finestre di riconciliazione



Le finestre di riconciliazione sono utilizzate per riconciliare un conto di GnuCash con l’estratto conto che la banca o un’altra istituzione ha inviato. La riconciliazione è utile non solo per controllare le proprie registrazioni nei confronti di quelle della banca, ma anche per avere un controllo sulle transazioni in sospeso come, per esempio, gli assegni non incassati.
Per aprire le finestre di riconciliazione, selezionare un conto dalla struttura dei conti e dirigersi in Operazioni → Riconcilia. Apparirà una finestra in cui sarà possibile immettere le informazioni di riconciliazione.
[image: Finestra di riconciliazione]La finestra iniziale di riconciliazione.



Nella finestra iniziale di riconciliazione, devono essere inserite alcune informazioni di riconciliazione
	Data dell’estratto conto
	La la data di emissione dell’estratto conto con cui verrà riconciliato il conto.
Suggerimento
Fare clic sulla freccia alla destra di questo campo per aprire un calendario


	Saldo iniziale
	Questa voce non è modificabile e visualizza il saldo della precedente riconciliazione. Dovrebbe corrispondere al saldo iniziale presente sull’estratto conto.
Avvertimento
Potrebbe capitare che il saldo iniziale in GnuCash non equivalga a quello presente sull’estratto conto. Ciò può accadere quando si riconcilia un conto per la prima volta o quando una transazione riconciliata in precedenza sia eliminata o la sua riconciliazione venga annullata.

Nota
Quando si riconcilia un conto per la prima volta, il saldo iniziale sarò pari a 0.00, e quindi probabilmente diverso dal bilancio di apertura del proprio conto. Quando il conto verrà riconciliato, il bilancio di apertura del conto verrà incluso nella riconciliazione, e il risultato finale dovrebbe essere in bilancio.

Suggerimento
Nel caso in cui venga de-reconciliata una transazione riconciliata in precedenza, è possibile riconciliarla con le transazioni presenti nell’ultimo estratto conto. Il risultato dovrebbe essere in bilancio.
Nel caso in cui una transazione già riconciliata venga eliminata, è più complesso; se non è possibile risalire alla transazione eliminata e ripristinarla nel registro, sarà necessario creare una transazione fittizia di pari importo per completare la riconciliazione.

Attenzione
While the latter case does not matter for your private accounting,
              you should have a really good explanation for your auditors, if you are the
              accountant of a club or a company.


	Saldo finale
	In questo campo dovrebbe essere inserito il saldo di chiusura così come appare nell’estratto conto.
Nota
GnuCash completa automaticamente questo campo con il saldo Attuale così come mostrato nella parte inferiore del registro del conto.


	Includi i sottoconti
	Check this option if you want to include in the reconciliation the transactions
            that belongs to the sub-accounts of the currently selected account. Note that all sub-accounts must be in the same commodity as the parent for the option to be enabled.

	Immissione pagamento interessi
	Premendo questo pulsante verrà aperta una finestra che permette di inserire una transazione per gli interessi nel conto che sta per essere riconciliato.
Suggerimento
The Interest Payment window might be opened automatically when you start a reconciliation 
	      for an account of the type Bank, Credit, 
	      Mutual, Asset, Receivable,
	      Payable, and Liability. If you want to disable
	      this behavior for any of the previous accounts, go to the Register tab of the 
	      GnuCash Preferences and uncheck the Automatic interest transfer
	      option. Alternatively, to disable this behavior only for the selected account, press the 
	      No Auto Interest Payments for this Account button in the 
	      Interest Payment window.




Premere poi il pulsante Ok e verrà visualizzata la lista delle transazioni nella finestra di riconciliazione:
[image: Finestra di riconciliazione]La lista delle transazioni nella finestra di riconciliazione.



I due riquadri chiamati Fondi in ingresso e Fondi in uscita elencano tutte le transazioni non riconciliate. La colonna R mostra se le transazioni sono state riconciliate.
Si esamini ora ogni voce dell’estratto conto e si ricerchi l’elemento corrispondente nella finestra di riconciliazione.
Se non si è in grado di trovarne una, è probabile che ci si sia dimenticati di immetterla oppure non si era al corrente della transazione. È possibile utilizzare il pulsante Nuovo sulla barra degli strumenti, o la voce di menu Transazione → Nuovo, per aprire la finestra del registro e inserire la transazione mancante. La nuova transazione apparirà nella finestra di riconciliazione alla pressione del pulsante Inserisci dopo aver immesso la transazione.
Quando si trova la voce corrispondente nella finestra di riconciliazione, confrontarne l’importo con quello che compare sull’estratto conto. Nel caso fossero diversi, potrebbe essere stato commesso un errore nell’immissione della transazione in GnuCash. È possibile utilizzare il pulsante Modifica nella barra degli strumenti o la voce del menu Transazione → Modifica, per aprire la finestra del registro e correggere la transazione.
Se gli importi corrispondono, fare clic sull’elemento nella finestra di Riconciliazione. Apparirà un segno di spunta nella colonna R a fianco della transazione selezionata. GnuCash aggiornerà automaticamente gli importi nel riquadro di ripilogo in basso a destra.
Suggerimento
È possibile utilizzare i tasti delle freccie su/giù per scorrere gli elementi, la barra spaziatrice per marcare l’elemento come riconciliato e il tasto Tab per cambiare riquadro.

Ripetere quindi queste operazioni per ogni voce presente nell’estratto conto della banca, verificando che l’importo corrisponda con quello in GnuCash e marcando le transazioni in GnuCash quando sono riconciliate.
In basso nella finestra di riconciliazione viene riportata la Differenza, che dovrebbe visualizzare €0,00 quando la riconciliazione è terminata. Se riporta qualche altro valore, o si è dimenticata una o più transazioni oppure alcuni importi potrebbero essere errati in GnuCash (o, più difficilmente, la banca ha fatto un errore).
Nota
Under some circumstances, it may be difficult or impossible to determine why an account will not reconcile. If you are unable to correct the discrepancy between your books and a statement, GnuCash includes a Balance button on the Toolbar that will automatically create a balancing entry for you in the amount that cannot be reconciled.
To use this, carry out the full reconciliation (marking all transactions that you can identify) and then click this button. GnuCash will create a balancing entry for the remaining discrepancy that uses the Special Accounts:Orphan-XXX account (where "XXX" represents your currency). The Reconcile window will close; re-opening it will allow you to check the newly-created balancing entry and finish the process.

When you have marked off all the items on the bank statement and the difference is 0.00, press the Finish button on the Toolbar or
      select Reconcile → Finish from the menu. 
      The Reconcile window will close.
      In the register window, the R field of the reconciled transactions will
      change to y.
In questo caso, non sono state ancora ricevute tutte le informazioni, così è stato premuto il pulsante Posticipa, in modo da poter proseguire in un secondo momento. Si osservi che la colonna R indica che sono state liquidate (l) due transazioni. Non sono state ancora riconciliate, ma si è verificata la loro riscossione e quindi sono state marcate come liquidate. Osservando la barra di stato in fondo al registro del conto, si noterà un sommario di ciò che è stato riconciliato e di ciò che è stato liquidato (Liquidato:€ 954.79; Riconciliato:€ 0.00)
[image: Conto corrente]Il conto corrente dopo aver posticipato la riconciliazione.





Business Preferences



Set options on the Business tab of the GnuCash preferences, which is
        accessed via Edit → Preferences
    (GnuCash → Preferences on Mac OS X).
        See Help manual chapter 10.3.3 Business Book Options Tab.
      

Procedere al pagamento



Verosimilmente, si riceverà il pagamento dai clienti per i quali è stata emessa una fattura. Per registrarlo, si utilizza la procedura di pagamento raggiungibile dal menu Impresa → Cliente → Procedura di Pagamento.
[image: Procedere al pagamento]Finestra della procedura di pagamento




Informazioni su questo documento



Lo scopo di questo manuale è di far risparmiare tempo introducendo l’utente all’utilizzo di GnuCash il più velocemente possibile.
Ogni capitolo segue uno schema molto semplice. Inizia con la discussione dei «concetti» che introducono l’argomento e la terminologia adottata nel capitolo stesso. In seguito c’è una sezione «come fare per...» che descrive la procedura da adottare nel programma per mettere in atto i concetti riportati nella sezione precedente; infine una sezione «in pratica» conclude il capitolo e fornisce dettagliati esempi di applicazione.
I neofiti troveranno le sezioni sui «concetti» molto utili dato che forniscono una guida su come tenere correttamente traccia delle proprie finanze e introducono ai concetti di contabilità e alla terminologia finanziaria. Gli utenti più esperti potranno invece saltare direttamente alle sezioni sul «come fare per...» per imparare subito le procedure descritte passo passo. Le sezioni «in pratica» forniscono delle lezioni sull’utilizzo del programma presentando degli esempi pratici. Iniziando con la creazione di un progetto nel Capitolo 2, Le basi, ogni capitolo successivo prosegue il lavoro realizzato in quello precedente.
Questo manuale è diviso in 3 parti: 
	Come Iniziare

	Managing Personal Finances

	Managing Business Finances



Getting Started provides you with the most
        basic information needed to begin using GnuCash. The chapters in this section explain concepts that are fundamental to using GnuCash. New users of GnuCash should familiarize themselves with the information in these chapters to get you up and running: 
	Capitolo 1, In generale - (this chapter) gives a general overview of GnuCash

	Capitolo 2, Le basi - gives users a very brief introduction to accounting principles, and then provides information about how GnuCash structures its data. There is also information on basic interface elements in GnuCash. Finally, this chapter explains how GnuCash stores and manages your data.

	Capitolo 3, Conti - gives further information about accounts and how to organize them.

	Capitolo 4, Transazioni - gives basic information about transactions and how to enter them.



Managing Personal Finances addresses
    common applications and features of GnuCash in greater detail. You will
    see more specific cases, based on frequently asked questions about
    applying GnuCash to everyday situations. Here are the applications and
    features covered in this part: 
	Capitolo 5, Libretto degli assegni

	Capitolo 7, Carte di credito

	Capitolo 8, Prestiti

	Capitolo 9, Investimenti

	Capitolo 10, Guadagni in conto capitale

	Capitolo 11, Valute multiple



Managing Business Finances discusses the
    use of GnuCash in business accounting: 
	Capitolo 12, Business  Introduction

	Capitolo 13, Business  Setup

	Capitolo 14, Crediti correnti

	Capitolo 15, Debiti correnti

	Capitolo 16, Libro paga

	Capitolo 17, Bilanci

	Capitolo 18, Altre attività

	Capitolo 19, Deprezzamento

	Capitolo 20, Python Bindings

	Capitolo 21, Importare i dati dell’impresa



This manual also includes several appendices, which contains extra information
    you might want to know:
	Appendice A, Guida alla migrazione - Guida per gli ex utenti di Quicken®, MS Money o altri utilizzatori di file QIF

	Appendice B, Domande poste frequentemente (FAQ)

	Appendice C, Contributed Account Trees

	Appendice D, Formati di file ausiliari

	Appendice E, Documentazione sulla licenza libera GNU (in inglese)



In ultimo un glossario e l’indice permettono di trovare facilmente gli argomenti che si stanno cercando.

Controllo dei dati QIF (Discussione)




 

Capitolo 18. Altre attività



Concetti generali



Questo capitolo illustra altre pratiche contabili per quelle attività, frequenti per le imprese, che necessitano di essere registrate sui libri contabili. Le spiegazioni seguenti riguardano sia la descrizione sia lo scopo dell’attività edincludono anche le comuni pratiche contabili (scrittura sui libri o registrazione) per le relative transazioni.
Questi concetti si sono evoluti sulla base di centinaia di anni di esperienza e aiuteranno a massimizzare l’utilità e la significatività della propria attività di registrazione.
This section introduces categorization of assets in the balance sheet
    based on time or the asset’s useful life (current and long-term). Sometimes
    assets are also considered from the standpoint of their liquidity
    , which is regarded as how close or distant the asset is from
    being turned into cash. Near-cash assets are relatively quickly converted
    to cash (e.g., accounts receivable), while assets requiring rather a long
    time to convert to cash are considered to be relatively fixed
     in their non-cash state (e.g., heavy equipment, buildings, land).
    (Fixed does not mean they were repaired!)
You should find that current assets parallel those with more liquidity,
     while long-term and fixed assets are those with much less liquidity. Finally,
     below you will find a few assets that could be either current or long-term
     based on the nature of the facts constituting them.


Calcoli



Determinare i piani di ammortamento per un prestito, gli importi delle rate, il valore totale o i tassi di interesse può risultare a volte complesso. Per assistere l’utente in questo tipo di calcoli, GnuCash incorpora un calcolatore di prestiti. Per accedervi, selezionare la voce Strumenti → Calcolatore di prestiti.
[image: Calcolatore di prestiti]Il calcolatore di prestiti di GnuCash.



Il calcolatore di prestiti può essere utilizzato per calcolare ognuno di questi parametri: Numero di rate, Tasso di interesse, Valore attuale, Rata , o Valore futuro, ammesso che gli altri quattro siano stati definiti. Sarà inoltre necessario specificare l’interesse composto e il metodo di pagamento.
	Numero di rate - il numero di rate in cui è suddiviso il prestito.

	Tasso di interesse - il tasso di interesse nominale del prestito, per esempio il tasso annuo di interesse.

	Valore attuale - il valore a oggi del prestito, per esempio l’importo ancora da versare per estinguere il prestito.

	Rata - l’importo da pagare come rata.

	Valore futuro - il valore futuro del prestito, per esempio l’importo ancora da versare alla scadenza del prestito.

	Interesse composto - esistono due metodi per calcolare l’interesse composto, discreto o continuo. Per l’interesse composto discreto, selezionare la frequenza dal menu a tendina con un intervallo variabile da annuale a quotidiano.

	Rata - il menu a tendina permette la scelta della frequenza di pagamento con un intervallo che va dall’anno al giorno. Si può anche scegliere se il pagamento avviene all’inizio od alla fine del periodo. Ai pagamenti all’inizio del periodo viene applicato il tasso di interesse can also select whether your payments occur at the beginning or end of the period. Payments made at the beginning of the payment period have interest applied to the payment as well as any previous money paid or money still owed.



Esempio: rate mensili



Quale sarebbe la rata mensile per un prestito di €100.000 da restituire in 30 anni a un tasso costante del 4% composto mensilmente?
Questa situazione è mostrata nell’immagine d’esempio più in alto. Per eseguire questo calcolo, si deve impostare il numero di rate a 360 (12 mesi per 30 anni), il tasso di interesse a 4, il valore attuale a 100.000, lasciare vuoto il capo della rata e impostare il valore futuro a 0 (si desidera estinguere completamente il prestito e non avere altro da pagare alla fine del mutuo). L’interesse composto va impostato a mensilmente, le rate sono anch’esse mensili assumendo il pagamento alla fine del periodo e l’interesse composto discreto. Premere quindi il pulsante Calcola. Il risultato dovrebbe essere €-477.42.
Risposta: la rata mensile ammonterebbe a €477.42.

Esempio: durata del prestito



Per quanto tempo si dovrebbe pagare un prestito di €20.000 al tasso fisso del 10% composto mensilmente e pagando una rata mensile di €500?
Per eseguire questo calcolo, lasciare vuoto il campo del numero di rate, impostare il tasso di interesse a 10, il valore attuale a 20.000, l’importo della rata a -500 e il valore futuro a 0 (si desidera estinguere completamente il prestito e non avere altro da pagare alla fine dello stesso). L’interesse composto va impostato a mensilmente, le rate sono anch’esse mensili assumendo il pagamento alla fine del periodo e l’interesse composto discreto. Premere quindi il pulsante Calcola. Il risultato dovrebbe essere 49.
Risposta: si dovrà pagare il prestito per 4 anni e 1 mese (49 mesi).

Avanzato: dettagli sui calcoli



Per poter discutere le formule matematiche utilizzate dal calcolatore di prestiti, è necessario definire prima di tutto alcune variabili. 


 n  == numero di rate

 %i  == tasso di interesse nominale applicato TAN

 PV  == valore attuale

 PMT == rata

 FV  == valore futuro

 CF == frequenza di composizione per anno

 PF == frequenza di pagamento per anno



Valori comuni per CF e PF sono:

   1   == annuale

   2   == semestrale

   3   == quadrimestrale

   4   == trimestrale

   6   == bimestrale

   12  == mensile

   24  == quindicinale

   26  == bisettimanale

   52  == settimanale

   360 == giornaliero

   365 == giornaliero



Conversione fra tasso di interesse nominale e effettivo



Quando si ha bisogno della soluzione per n, PV, PMT o FV, Il tasso di interesse nominale «i» deve prima essere convertito in quello effettivo «ieff». Quest’ultimo è poi utilizzato per calcolare la variabile selezionata. Quando si vuole invece conoscere il valore di «i», il calcolo fornisce il tasso di interesse efficace «ieff». Quindi, occorre conoscere la relazione che lega i valori di «i» e di «ieff».


Per calcolare «i» noto «ieff», vengono utilizzate le seguenti espressioni:

Interesse discreto:     ieff = (1 + i/CF)^(CF/PF) - 1

Interesse continuo: ieff = e^(i/PF) - 1 = exp(i/PF) - 1



Per calcolare «ieff» noto «i», vengono utilizzate le seguenti espressioni:

Interesse discreto:      i = CF*[(1+ieff)^(PF/CF) - 1]

Interesse continuo: i = ln[(1+ieff)^PF]



Nota
NOTA: nelle equazioni seguenti per le transazioni finanziarie, tutti i tassi di interesse indicati sono effettivi cioè «ieff». Per maggiore brevità si utilizzerà comunque il simbolo «i» come abbreviazione di «ieff».


L’equazione fondamentale della finanza



Una sola equazione lega tutte e 5 le variabili. Questa formula è nota come l’equazione fondamentale della finanza:


PV*(1 + i)^n + PMT*(1 + iX)*[(1+i)^n - 1]/i + FV = 0



  Dove: X = 0 per i pagamenti alla fine del periodo, e

        X = 1 per i pagamenti all’inizio del periodo



Partendo da questa equazione, possono essere ricavate le relazioni che esplicitano ogni variabile. Per una spiegazione più dettagliata su come vengono ricavate queste equazioni, consultare il file src/calculation/fin.c nel codice sorgente di 


A = (1 + i)^n - 1

B = (1 + iX)/i

C = PMT*B



n = ln[(C - FV)/(C + PV)]/ln((1 + i)

PV = -[FV + A*C]/(A + 1)

PMT = -[FV + PV*(A + 1)]/[A*B]

FV = -[PV + A*(PV + C)]



La soluzione per l’interesse è suddivisa in due casi.  

Il caso semplice in cui PMT == 0 fornisce la soluzione:

i = [FV/PV]^(1/n) - 1





Il caso in cui PMT != 0 è piuttosto complesso e non verrà discusso in questa sede. Invece di prevedere una funzione esplicita, la determinazione del tasso di interesse quando PMT !=0, prevede un metodo iterativo. Consultare il file sorgente src/calculation/fin.c per una spiegazione dettagliata.

Esempio: rate mensili



Ricalcolare la sezione chiamata «Esempio: rate mensili», usando però le formule matematiche anziché il calcolatore di prestiti. Quale sarebbe la rata mensile per un prestito di €100.000 da restituire in 30 anni a un tasso costante del 4% composto mensilmente?
Si definiscano per prime le variabili: n = (30*12) = 360, PV = 100000, PMT = incognita, FV = 0, i = 4%=4/100=0.04, CF = PV = 12, X = 0 (pagamento alla fine del periodo).
Il secondo passo consiste nel convertire il tasso di interesse nominale «i» in quello effettivo «ieff». Dato che l’interesse è composto mensilmente ed è discreto si utilizza la formula: ieff = (1 + i/CF)^(CF/PF) - 1, che fornisce ieff = (1 + 0.04/12)^(12/12) - 1, quindi ieff = 1/300 = 0.0033333.
È ora possibile calcolare A e B. A = (1 + i)^n - 1 = (1 + 1/300)^360 - 1 = 2.313498. B = (1 + iX)/i = (1 + (1/300)*0)/(1/300) = 300.
Noti A e B, si può calcolare PMT. PMT = -[FV + PV*(A + 1)]/[A*B] = -[0 + 100000*(2.313498 + 1)] / [2.313498 * 300] = -331349.8 / 694.0494 = -477.415296 = -477.42.
Risposta: la rata mensile ammonterebbe a €477.42.



Capitolo 4. Transazioni



Questo capitolo fornisce le conoscenze necessarie per poter utilizzare le transazioni in GnuCash. Mentre i conti rappresentano l’ossatura e la struttura di un diagramma dei conti, le transazioni costituiscono i dati che completano ogni conto.
Concetti base



A transaction in a double entry accounting
    system such as GnuCash is an exchange between at least 2 accounts. Thus, a
    single transaction must always consist of at least two parts, a from and
    a to account. The from account is transferring value to the to account.
    Accountants call these parts of a transaction Ledger
    Entries. In GnuCash, they are called
    Splits.
A split identifies the account to which it refers, the
    amount of money specifically moved to or from that account, and
    can contain a few other specific pieces of information if needed.
    GnuCash supports multiple splits in a
    single transaction, and the splits can move money into or out of
    the involved accounts arbitrarily.
Per esempio, si consideri lo stipendio che si riceve e che viene depositato nel proprio conto di risparmio in banca. La transazione avviene poiché il conto di risparmio (appartenete alle attività) riceve il denaro dal conto delle entrate. Due conti sono interessati dall’operazione e, in questo caso, si verifica anche un aumento del capitale.
Le operazioni con le transazioni in GnuCash avvengono in quello che viene denominato registro contabile; a ogni nuovo conto che viene creato è automaticamente associato un registro contabile. Il registro apparirà familiare dato che è molto simile al registro per tenere traccia degli assegni.
The account register is explained in the upcoming section,
    la sezione chiamata «Il registro contabile».


Appendice A. Guida alla migrazione



Questa appendice è di supporto agli utenti di altri software finanziari nella migrazione a GnuCash. Saranno descritte le differenze di impostazioni di GnuCash confrontandole con quelle di altri programmi.
Usare i conti in luogo delle categorie



Se si ha familiarità con altri programmi per la gestione delle finanze personali, si sarà già abituati a tenere traccia delle proprie entrate e uscite come categorie. Dato che GnuCash utilizza un sistema a partita doppia (consultare la sezione 2.1), entrate e uscite sono trattate come conti. Il concetto di base è lo stesso, ma la struttura a conti presenta una maggiore coerenza con l’uso commerciale comune. Così, sia che si utilizzi per gestire la propria attività o per le proprie finanze personali, GnuCash permette di tenere facilmente traccia di ogni operazione.
I conti per le entrate e per le uscite forniscono le stesse informazioni contenute nelle categorie ma in più forniscono maggiore flessibilità nell’immissione delle transazioni. In GnuCash si ha infatti la possibilità di inserire direttamente le transazioni attraverso il relativo registro contabile; i programmi che utilizzano le categorie non offrono questa possibilità perché, per le categorie, non esiste un «registro contabile».
In GnuCash si ha anche la possibilità di trattare i conti di entrate e uscite esattamente come si tratterebbero le categorie, se ci si sente più a proprio agio con quest’ultimo metodo. In Quicken® e altri programmi simili, le transazioni hanno bisogno di un conto e di una categoria. Sostituendo un nome di conto entrate o uscite in GnuCash con il nome della categoria uitlizzata nell’altro programma, il risultato dovrebbe essere identico. L’immissione delle transazioni è discusso in dettaglio al capitolo 4.


Capitolo 14. Crediti correnti



Per crediti correnti si intendono quei prodotti o servizi forniti dalla propria società e per i quali non è ancora stato ricevuto il pagamento.
Configurazione iniziale



Perform set up tasks listed in Capitolo 13, Business  Setup.
    


Immettere i prelievi



Quando si preleva per una qualsiasi ragione una somma dal conto bancario, si sta trasferendo del denaro dal conto bancario verso un’altra destinazione. In GnuCash, quest’altra destinazione è registrata come un conto. Più conti di dettaglio si creano e utilizzano per le uscite, maggiori saranno le informazioni disponibili sulla destinazione del proprio denaro.
I prelievi possono assumere diverse forme. I prelievi da ATM rappresentano le transazioni più diffuse. Scrivere assegni è un altro modo per prelevare denaro al fine di pagare le bollette, per fare acquisti o per fare beneficenza. In funzione della banca, si possono avere anche costi di servizio in cui la banca preleva denaro dai conti. I trasferimenti di denaro verso un altro conto rappresentano anch’essi dei prelievi. Di seguito si tratterà ogni tipo di prelievo e se ne descriverà la procedura di inserimento in GnuCash.
ATM: prelievo di contanti



I prelievi di contanti sono trattati come trasferimenti da un conto bancario a un conto dei liquidi. GnuCash fornisce conti speciali per i Liquidi in grado di tenere traccia dei prelievi di contanti, così è necessario impostare un conto per i contanti allo scopo di registrare i propri prelievi sia con ATM che con altre modalità.
I conti per i liquidi possono essere utilizzati con diversi livelli di dettaglio. Al livello più semplice, si trasferisce semplicemente il contante dal conto corrente. Questo però indica solamente la quantità di denaro prelevata dal conto corrente in un determinato giorno, ma non fornisce informazioni sulla destinazione del denaro. Con poco impegno in più, è possibile utilizzare il conto per i liquidi per registrare anche gli acquisti in contanti in modo da poter conoscere la destinazione precisa del denaro. Questi acquisti verranno registrati come trasferimenti di denaro dal conto dei liquidi al conto delle uscite.
Alcune persone registrano ogni acquisto in contanti, ma questo richiede molto lavoro. Un metodo più semplice consiste nel registrare gli acquisti per i quali si ha una ricevuta, aggiustando poi il saldo del conto in base a quanto rimane nel portafoglio.
Si consiglia di impostare almeno un conto dei liquidi per registrare i propri prelievi. Se poi si decidesse di registrare anche la destinazione del proprio denaro, è sempre possibile inserire delle transazioni per il denaro speso. L’utente è libero di scegliere il dettaglio di livello che preferisce.


Impostare i conti



Per iniziare a gestire la propria carta di credito con GnuCash, si deve impostare un conto delle Passività di livello principale e al suo interno creare tanti conti figli del tipo carta di credito quante sono le carte che si vogliono tracciare. Per registrare solamente i pagamenti effettuati alla compagnia della carta di credito, tutto quello di cui si ha bisogno è un conto per la banca e uno per la carta di credito dove immettere le transazioni.
Le spese effettuate con la carta di credito sono delle uscite ed è quindi necessario impostare questi conti come figli di un conto di livello principale denominato Uscite. Se si decide di utilizzare un maggiore livello di dettaglio degli acquisti, sarà necessario creare un conto uscite per ogni tipo di acquisto che si effettua. Dato che sarà anche necessario riconciliare il saldo con l’estratto conto della carta, sarà utile impostare un bilancio di apertura per ogni conto di carta di credito. Il metodo più semplice per farlo consiste nell’utilizzare come bilancio di apertura, il saldo dell’ultimo estratto conto.
Schema semplice



Se non si desidera registrare ogni spesa sostenuta con la carta di credito, è sufficiente creare una semplice struttura dei conti come questa:


-Attività

   -Banca

-Passività

   -Carta di credito

-Uscite

   -Carta di credito

   

In questo esempio, si immette l’importo totale addebitato ogni mese come una transazione tra il conto Passività:Carta di credito e il conto Uscite:Carta di credito. Quando si effettua un pagamento si deve inserire una transazione tra Attività:Banca e Passività:Carta di credito.
La limitazione ovvia di questo semplice schema per la carta di credito, risiede nel fatto che non è possibile vedere dove il denaro viene impiegato. Tutte le spese effettuate con la carta di credito sono inserite nel conto delle uscite per la carta di credito. Comunque, questo sistema è facilmente configurabile e aggiornabile.

Schema completo



Se si desidera registrare le spese in modo più completo, occorre impostare più conti per le uscite denominati a seconda dei vari tipi di acquisti che si possono effettuare. Ogni addebito sulla carta di credito è immesso come una transazione separata tra il conto delle passività della carta di credito e il conto specifico per l’uscita. Di seguito si riporta un esempio di struttura dei conti per questo caso:


-Attività

    -Banca

-Passività

    -Carta di credito

-Uscite

    -Cibo

    -Auto

    -Vestiti

    -Intrattenimento

    -Interessi

    -Servizi

   

Chiaramente, è necessario inserire delle uscite specifiche a seconda delle proprie abitudini di acquisto. L’unica differenza tra questo schema e quello semplice, riguarda le uscite che ora sono suddivise in gruppi. Si noti anche la presenza di una uscita denominata «Interessi»; questa è utilizzata quando la carta di credito richiede il pagamento degli interessi sul denaro che mensilmente non è ancora stato restituito. Il conto delle uscite denominato «Servizi» permette di tenere traccia delle spese di servizio associate all’utilizzo della carta di credito, quali il costo fisso annuo di utilizzo se esiste. Con questo schema, si sarà in grado di controllare dove il denaro viene speso ogni mese e raggrupparlo in funzione dei conti delle uscite.
Il resto di questo capitolo assumerà che si stia utilizzando lo schema completo.


Esempio



Si supponga di acquistare un bene per cui si prevede un aumento del valore, quale un quadro di Degas, e di volerne tenere traccia (se ne occuperà la compagnia di assicurazione, anche se nessun altro lo farà).
Start with an account hierarchy similar to that shown in la sezione chiamata «Impostare i conti», but replace «ITEM1» with «Degas» and you
    can remove the «ITEM2» accounts. We will assume that the Degas painting
    had an initial value of one hundred thousand dollars. Begin by giving your
    self $100,000 in the bank and then transferring that from your bank
    account to your Assets:Fixed Assets:Degas:Cost account (the asset
    purchase transaction). You should now have a main account window which
    appears like this:
[image: Finestra principale di rivalutazione del bene]La finestra principale dell’esempio sulla rivalutazione di un bene



Guadagni non realizzati



Un mese dopo, si ha ragione di credere che il valore del quadro sia aumentato di €10.000 (un guadagno non realizzato). Per registrare questo aumento, occorre inserire un trasferimento di €10.000 dal conto dei propri guadagni accumulabili (Entrate:Guadagni non realizzati) al conto dei guadagni non realizzati (Attività:Beni immobili:Degas:Guadagni non realizzati). La finestra principale assomiglierà a questa:
[image: Finestra principale di rivalutazione del bene]La struttura dei conti dopo l’inserimento del guadagno non realizzato




Vendere



Si supponga che un altro mese dopo i prezzi dei quadri di Degas siano saliti ancora un po’, in questo caso di circa €20.000, come dalle proprie stime. Puntualmente si registreranno i €20.000 come entrate derivanti da guadagni non realizzati; poi si decide di vendere il quadro.
Si presentano tre possibilità: si potrebbero aver correttamente stimato i guadagni non realizzati, sottostimato i guadagni non realizzati o sovrastimato i guadagni non realizzati.
	Stima accurata dei guadagni non realizzati.
Le proprie stime ottimistiche del prezzo del quadro erano corrette. Prima di tutto si deve registrare che i profitti ottenuti sono ora guadagni realizzati, e non guadagni non realizzati. Questo si effettua trasferendo le entrate dal conto Entrate:Guadagni non realizzati al conto Entrate:Guadagni realizzati.
In secondo luogo, occorre accreditare il conto bancario con il prezzo di vendita del quadro. Questo denaro proviene direttamente dal sottoconto Attività:Beni immobili:Degas. Si trasferisca l’intero valore del conto Attività:Beni immobili:Degas:Costo nel conto Attività:Beni immobili:Conto risparmio e l’intero valore del conto Attività:Beni immobili:Degas:Guadagni non realizzati nel conto Attività:Attività correnti:Conto risparmio.
Queste transazioni dovrebbero apparire così:
Tabella 10.1. Convertire un guadagno accumulato in un guadagno realizzato
	Conto	Trasferimento a	Importo della transazione	Totale del conto
	Entrate:Guadagni non realizzati	Entrate:Guadagni realizzati	€30.000	€0
	Attività:Beni immobili:Degas:Costo	Attività:Attività correnti:Conto risparmio	€100.000	€0
	Attività:Beni immobili:Degas:Guadagni non realizzati	Attività:Attività correnti:Conto risparmio	€30.000	€0





Questo porta i saldi dei conti Attività:Attività correnti:Conto risparmio e Entrate:Guadagni realizzati a un totale rispettivamente di €130.000 ed €30.000.
[image: Finestra principale di rivalutazione del bene]La struttura dei conti dopo l’inserimento dei guadagni realizzati




	Sottostima dei guadagni non realizzati.
You were over-optimistic about the value of the painting.
          Instead of the $130000 you thought the painting was worth you are only
          offered $120000. But you still decide to sell, because you value
          $120000 more than you value the painting. The numbers change a
          little bit, but not too dramatically.
Le transazioni dovrebbero apparire come nell’immagine seguente (si osservi che l’ultima transazione che bilancia i conti dei Guadagni non realizzati):
Tabella 10.2. Convertire un guadagno accumulato in un guadagno realizzato
	Conto	Trasferimento a	Importo della transazione	Totale del conto
	Entrate:Guadagni non realizzati	Entrate:Guadagni realizzati	€20.000	€10.000
	Attività:Beni immobili:Degas:Costo	Attività:Attività correnti:Conto risparmio	€100.000	€0
	Attività:Beni immobili:Degas:Guadagni non realizzati	Attività:Attività correnti:Conto risparmio	€20.000	€10.000
	Attività:Beni immobili:Degas:Guadagni non realizzati	Entrate:Guadagni non realizzati	€10.000	€0





Questo porta i saldi dei conti Attività:Attività correnti:Conto risparmio e Entrate:Guadagni realizzati a un totale rispettivamente di €120.000 ed €20.000.

	Sovrastima dei guadagni non realizzati.
Si supponga di riuscire a vendere il quadro a un prezzo superiore alle proprie più rosee previsioni: €150.000. Il plusvalore è, di nuovo, trattato come un guadagno, cioè un’entrata.
Le transazioni dovrebbero apparire come nell’immagine seguente (si osservi che l’ultima transazione che bilancia i conti dei guadagni non realizzati):
Tabella 10.3. Convertire un guadagno accumulato in un guadagno realizzato
	Conto	Trasferimento a	Importo della transazione	Totale del conto
	Entrate:Guadagni non realizzati	Entrate:Guadagni realizzati	€50.000	€-20.000
	Attività:Beni immobili:Degas:Costo	Attività:Attività correnti:Conto risparmio	€100.000	€0
	Attività:Beni immobili:Degas:Guadagni non realizzati	Attività:Attività correnti:Conto risparmio	€50.000	€-20.000
	Entrate:Guadagni non realizzati	Attività:Beni immobili:Degas:Guadagni non realizzati	€20.000	€0





Questo porta i saldi dei conti Attività:Attività correnti:Conto risparmio e Entrate:Guadagni realizzati a un totale rispettivamente di €150.000 ed €50.000.





In pratica



Ora che sono stati affrontati i concetti di base che stanno dietro le varie transazioni che si devono effettuare per tracciare correttamente la propria carta di credito in GnuCash, si procederà alla illustrazione di un esempio: si effettueranno degli acquisti con la carta di credito, si rimborseranno due di essi, si pagheranno gli interessi sull’importo non pagato, si riconcilierà il conto della carta e, infine, si effettuerà un pagamento parziale della carta di credito.
Aprire un file di GnuCash



Si inizi aprendo il file dei dati salvato in precedenza, gcashdata_5 e lo salvare come gcashdata_6 da subito. La finestra principale dovrebbe assomigliare a questa:
[image: Struttura dei conti iniziale]Struttura dei conti iniziale per il tracciamento di una carta di credito nell’esempio pratico.




Acquisti



Si supponga di effettuare degli acquisti con la carta Visa. Si inizi acquistando €25 di cibo dal Greasy Spoon Cafe, €100 di capi di vestiario da Faux Pas Fashions, €25 di carburante da Premium Gasoline, €125 di generi alimentari e casalinghi da Groceries R Us (suddivisi in €85 di alimentari ed €40 in oggetti per la casa) e infine, €60 di articoli per la casa da CheapMart.
Si ripeta anche l’esercizio del capitolo precedente, acquistando un paio di Jeans per €74.99 il 3 Aprile, e si restituiscano due giorni dopo.
La finestra del registro per le passività della carta di credito dovrebbe assomigliare a questa:
[image: Acquisti iniziali con la carta di credito]Acquisti iniziali con la carta di credito.




Rimborso



Si supponga ora che il 15 Aprile siano stati restituiti i vestiti acquistati l’11 Aprile da Faux Pas Fashions e che sia stato rimborsato il costo sulla carta di credito. Inserire una transazione per il rimborso della carta di credito per l’intero importo di €100. È necessario utilizzare lo stesso conto di trasferimento utilizzato per l’acquisto, e inserire l’importo nella colonna del pagamento. GnuCash automaticamente completerà il nome e il conto di trasferimento, ma immetterà anche automaticamente i €100 nella colonna dell’addebito. Sarà necessario reinserire l’importo nella colonna dei pagamenti. La transazione sarà come questa:
[image: Transazione per la restituzione dell’oggetto]Restituzione dei vestiti a Faux Pas Fashions, rimborso sulla carta di credito.




Interessi



Dopo il mese di acquisti, sfortunatamente, arriva per posta la ricevuta della carta di credito oppure si accede a essa tramite internet. Si scopre che sono stati addebitati €20 di interessi nell’ultimo giorno di Aprile a causa del saldo del mese precedente. Questo viene immesso come una spesa nel conto della carta di credito.
[image: Interessi]Interessi.




Riconciliazione



All’arrivo della ricevuta della carta di credito, si dovrebbe riconciliare il conto della carta di credito con questo documento. Questo può essere fatto utilizzando l’applicazione di riconciliazione fornita da GnuCash. Evidenziare il conto della carta di credito e selezionare Operazioni → Riconcilia.... Questa procedura di riconciliazione è descritta dettagliatamnete in la sezione chiamata «Riconciliazione», ma comunque ne verrà descritto il processo anche qui. Per questo esempio, si assuma che l’estratto conto della carta di credito sia datato 1 Maggio, con un saldo finale di €455. Inserire questi valori nella finestra iniziale di riconciliazione come mostrato qui.
[image: Finestra iniziale di riconciliazione]Finestra iniziale di riconciliazione del conto.



Durante il processo di riconciliazione, si devono marcare tutte le transazioni nel conto quando si è certi che esse compaiono sia nel conto di GnuCash, sia nell’estratto conto della carta. In questo esempio, come mostrato nella figura più sotto, c’è una differenza di €300 tra i conti di GnuCash e il documento della carta di credito.
[image: Finestra principale di riconciliazione]Finetsra principale di riconciliazione del conto, dove è visualizzata una differenza di €300.



Dopo alcune analisi, si scopre di aver dimenticato di registrare un pagamento effettuato il 5 Marzo in favore della compagnia della carta di credito per un importo di €300; questo pagamento deve essere inserito con una transazione dal conto corrente bancario al conto della carta di credito. A questo punto il documento della carta di credito e il conto di GnuCash possono essere riconciliati, con un saldo di €455.

Pagamento



Nell’ipotesi che sia stata completata la riconciliazione del conto della carta di credito, è necessario effettuare un pagamento alla compagnia della carta di credito. In questo esempio, si è in debito di €455 ma si restituiranno solamente €300 ancora per questo mese. Per fare questo, inserire una transazione dal proprio conto bancario al conto della carta di credito, per una somma di €300, che dovrebbe diminuire il saldo della carta di credito portandolo a €155. Il registro del conto della carta di credito dovrebbe ora assomigliare a questo:
[image: Riconciliazione e pagamento]Registro del conto dopo la riconciliazione e il pagamento.



Tornare alla finestra principale e salvare il file (gcashdata_6). La struttura dei conti sta continuamente crescendo e dovrebbe assomigliare a questa:
[image: GnuCash finestra principale]Struttura dei conti di GnuCash dopo la riconciliazione e il pagamento.




Salvare il file



In ultimo, salvare il file dei dati di GnuCash (gcashdata_6).

Resoconti



Come è stato fatto nel precedente capitolo, si darà uno sguardo ai resoconti per il Flusso di liquidi e per le Transazioni.
	Dapprima si analizzi il resoconto del Flusso di liquidi per il conto Visa delle passività per il mese di Marzo.
Selezionare il resoconto dei flussi di liquidi da Resoconti → Entrate e uscite → Flusso di liquidi.
[image: Resoconto dei flussi di liquidi per il mese di Marzo]Questa immagine mostra il resoconto del flusso di liquidi dopo il Capitolo 7, Carte di credito.




	Controllare ora il corrispondente resoconto delle transazioni per il conto Visa.
Selezionare il resoconto delle transazioni dal menu Resoconti → Resoconto delle transazioni.
[image: Resoconto delle transazioni per il conto Visa nei mesi di Marzo e Aprile]Questa immagine mostra il resoconto delle transazioni per il conto Visa nei mesi di Marzo e Aprile.




	Cambiare ora il resoconto delle transazioni in modo da mostrare solamente i vari conti delle uscite.
[image: Resoconto delle transazioni per i conti delle uscite nel mese di Aprile]Questa immagine mostra il resoconto delle transazioni per i vari conti delle uscite nel mese di Aprile.








In pratica



Nelle sezioni precedenti di questo capitolo sono stati discussi i concetti e la meccanica di lavoro con le transazioni di GnuCash. Questa sezione si svilupperà a partire dalla struttura dei conti creata nel precedente capitolo aggiungendo dei bilanci di apertura, delle transazioni e delle transazioni pianificate.
Aprire un file di GnuCash



Si inizi aprendo il file dei dati salvato in precedenza, gcashdata_3emptyAccts, e lo salvare come gcashdata_4 da subito. La finestra principale dovrebbe assomigliare a questa:
[image: Punto di partenza per la pratica]Questa immagine mostra il punto di partenza per questa sezione.




Bilanci d’apertura



Come mostrato per il conto Attività:Conto corrente, i bilanci di apertura di un conto sono tipicamente assegnati a un conto speciale denominato Capitali:Bilanci d’apertura. Per cominciare a popolare la struttura dei conti, si impostino i bilanci di apertura dei conti. Si assuma anche che ci siano €1.000 nei risparmi e €500 di addebito per la carta di credito.
	Aprire il registro del conto Attività:Conto risparmio. Selezionare Visualizza dal menu e controllare di aver impostato lo stile del registro a libro mastro basilare. Si vedranno le transazioni nelle altre due modalità in seguito; per ora è sufficiente creare una semplice transazione utilizzando lo stile predefinito di base.

	Dalla finestra del registro del conto Attività:Conto risparmio, inserire una semplice transazione tra 2 conti per impostare il bilancio di apertura a €1.000, trasferito da Capitali:Bilanci d’apertura. Si ricorda che una transazione semplice trasferisce denaro da un conto sorgente ad un conto di destinazione. Registrare la transazione (premere invio o fare clic sul pulsante Inserisci).

	Dalla finestra del registro del conto Attività:Conto corrente, inserire una transazione tra 2 conti al fine di impostare il bilancio di apertura a €1.000, trasferiti da Capitali:Bilanci d’apertura.

	Dalla finestra del registro del conto Passività:Visa, inserire una transazione tra due conti per impostare il bilancio di apertura a €500, trasferiti dal conto Capitali:Bilanci d’apertura. Questo si ottiene inserendo €500 come addebito nel conto Visa (o diminuzione nel conto dei bilanci di apertura), dato che si tratta di denaro chiesto in prestito. Registrare infine la transazione (premere Invio o fare clic sul pulsante Inserisci).



Si dovrebbero ora avere 3 conti con i relativi bilanci di apertura impostati: Attività:Conto corrente, Attività:Conto risparmio e Passività:Visa.
[image: Diagramma dei conti dopo aver impostato i bilanci d’apertura]Questa immagine mostra i bilanci di apertura .




Esempi di altre transazioni



Si aggiungano ora altre transazioni per simulare delle spese mensili. Durante il mese, €78 sono spesi per l’elettricità, €45 per il telefono ed €350 per l’affitto; si supponga che venga tutto pagato con il conto corrente. Si spendano inoltre €45,21 in generi alimentari, si riceva uno stipendio di €670 e si paghi una tariffa per il servizio internet. Si spostino poi €100 dal conto dei risparmi al conto corrente.
	Aprire il registro del conto Uscite:Elettricità e inserire una transazione per pagare €78 per la bolletta elettrica alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: Società elettrica) e il numero dell’assegno (esempio: 102). Il conto di trasferimento dovrebbe essere Attività:Conto corrente.

	Aprire il registro del conto Attività:Conto corrente e inserire una transazione per pagare €45 di bolletta telefonica alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: il nome della compagnia telefonica) e il numero dell’assegno (esempio: 103). Il conto di Trasferimento dovrebbe essere Uscite:Telefono. Si noti che è possibile inserire le transazioni sia dal lato dell’accredito (conto delle uscite) che dal lato dell’addebito (il conto delle attività).

	Aprire il registro del conto Uscite:Affitto e inserire una transazione per pagare €350 di affitto alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: affitto Aprile) e il numero dell’assegno (esempio: 104). Il conto di Trasferimento dovrebbe essere Attività:Conto corrente.

	Si duplichi ora questa transazione utilizzando il pulsante Duplica sulla barra degli strumenti. Iniziare facendo clic nella transazione selezionata per l’affitto e premendo poi il pulsante Duplica. Inserire la data della transazione un mese più avanti (esempio: 28 Aprile 2006). Si noterà la comparsa di una linea separatrice di colore blu che GnuCash utilizza per separare le transazioni correnti da quelle future. In questo modo è possibile inserire delle transazioni prima che avvengano.
È anche possibile impostare una transazione pianificata per pagare l’affitto dato che l’importo della rata è probabilmente costante nel futuro prossimo. 
	Si inizi selezionando la transazione per l’affitto (28 Aprile) e si prema l’icona Pianifica.

	Modificare in Mensile, cambiare la descrizione se necessario e premere OK




	Per trasferire denaro dal conto dei risparmi al conto corrente, aprire il conto Attività:Conto risparmio e aggiungere una nuova transazione impostando il trasferimento a Attività:Conto corrente di un importo pari a €100 (datato 6 Marzo 2006).

	Come ulteriore esempio di semplice transazione a due conti, si aggiunga una nuova transazione per registrare un acquisto di generi alimentari per €45,21 effettuato il 5 Marzo. Dal conto Attività:Conto corrente impostare un Trasferimento a Uscite:Alimentari. Il registro del conto dovrebbe apparire così:

	Per aggiungere una transazione per la busta paga dalla finestra del registro del conto Attività:Conto corrente, selezionare una nuova riga per la transazione e fare clic sul pulsante Suddivisione. Nella prima riga inserire la descrizione della transazione (per esempio: «Employers R Us») e la data (14 Marzo). Al di sotto di questa, nella riga della «suddivisione», inserire l’importo del deposito nel conto Attività:Conto corrente (per esempio: €670). In seguito inserire i depositi per le imposte (Attività:Conto corrente (per esempio: €670), Uscite:Imposte:Statali (per esempio: €180), Uscite:Imposte:Assistenza sanitaria (per esempio: €90), Uscite:Imposte:Previdenza sociale (per esempio: €60) e, in ultimo, il totale lordo dello stipendio (per esempio: €1000) come prelievo dal conto Entrate:Stipendio.

	Si deve anche pagare la sottoscrizione internet di 20 Euro il giorno 28.



[image: Struttura dei conti dopo aver impostato tutte le varie transazioni]Questa immagine mostra il saldo finale dopo il Capitolo 4, Transazioni.




Salvare il file



Prima di procedere alla sezione sui resoconti, salvare il file di GnuCash (nome gcashdata_4).

Resoconti



Avere a disposizione i dati solo tramite lo schermo del computer non è sempre sufficiente. Per questo GnuCash mette a disposizione dell’utente un grande numero di resoconti ampiamente personalizzabili.
Si analizzeranno ora i resoconti per il Flusso di liquidi e il Resoconto delle transazioni.
	Per primo verrà analizzato il resoconto del Flusso di liquidi per il mese di Marzo.
Selezionare il resoconto dei flussi di liquidi da Resoconti → Entrate e uscite → Flusso di liquidi.
[image: Resoconto dei flussi di liquidi per il mese di Marzo]Questa immagine mostra il resoconto dei flussi di liquidi dopo il Capitolo 4, Transazioni.



Per ottenere questo resoconto personalizzato, fare clic con il tasto destro del mouse nel resoconto e scegliere Opzioni resoconto. Impostare poi il periodo e specificare quali conti si vogliono includere nel resoconto.

	Controllare ora il resoconto delle transazioni per il conto corrente.
Selezionare il resoconto delle transazioni dal menu Resoconti → Resoconto delle transazioni.
[image: Resoconto delle transazioni per il conto corrente nel mese di Marzo]Questa immagine mostra il resoconto delle transazioni per il conto corrente nel mese di Marzo.




	Cambiare ora il resoconto delle transazioni in modo da mostrare solamente i vari conti delle uscite.
[image: Resoconto delle transazioni per il conto uscite nel mese di Marzo]Questa immagine mostra il resoconto delle transazioni per i vari conti delle uscite nel mese di Marzo.








Capitolo 6. Expense Accounts



If managing your checkbook is the first step in tracking your finances, then using expense accounts 
  to see where you are expending money is a close second step. This chapter will give you an understanding of 
  how GnuCash uses expense accounts to help you keep track of many different 
  categories of transactions.
Concetti



An expense type account is used to allow you to track how much you spend on specific 
    expenses. Technically, expense accounts are not a part of traditional accounting,
    but have become common with the increased capabilities of computer-based accounting systems.
    Many people's first experience with tracking expenses comes from Quicken(tm), where 
    transactions can be assigned to one or more categories. In GnuCash, these categories 
    are set up as separate accounts, which are designated as Expense type accounts. 
    This allows GnuCash to apply the rules of double-entry accounting consistently. 
    Expense accounts can be as detailed or as general as you need. Some users need only a few accounts for 
    personal expense tracking. Others use GnuCash expense accounts to manage their expenses 
    in great detail. The level of detail you choose is up to you. Keep in mind that with GnuCash, 
    you can change accounts for transactions, so if your needs change later on, it is possible to move 
    transactions around.


Capitolo 1. In generale



Introduzione



GnuCash è un pacchetto software di gestione delle finanze personali. È sufficientemente versatile per tenere traccia di tutte le transazioni finanziarie, dalle più semplici a quelle più complesse; è uno dei pochi software finanziari che supporta tutte le valute del mondo ed è l’unico a codice aperto. Se questo non bastasse, è anche molto semplice imparare a usarlo.
GnuCash permette di tenere traccia delle transazioni finanziare con il livello di dettaglio che si preferisce. Se si è all’inizio, è possibile utilizzare GnuCash per tenere traccia dei propri assegni. In seguito si potrà decidere di considerare anche le spese sostenute con la carta di credito per meglio conoscere dove il denaro viene speso. Quando si inizierà a investire, sarà possibile utilizzare GnuCash per monitorare le proprie azioni. Si sta per comprare un’auto o una casa? GnuCash aiuterà a pianificare l’investimento e a registrare le rate dell’eventuale mutuo. Se le transazioni finanziarie che si eseguono sono a livello globale, GnuCash offre tutto ciò che serve per gestire le valute di ogni parte del mondo.
[image: GnuCash struttura dei conti - anteprima]Questa immagine mostra le finestre dei conti e dei resoconti di GnuCash con valute multiple e investimenti.



Anche se GnuCash si presta alla gestione delle finanze personali, è anche sufficientemente potente per un utilizzo professionale. GnuCash presenta infatti diverse caratteristiche dedicate all’impresa: dall’integrazione del sistema dei conti per debiti e crediti correnti, alla costruzione di tabelle per le tasse. Queste e molte altre funzioni dedicate all’attività professionale risulteranno sorprendentemente potenti e facili da usare.


Contabilità



D: Come devo trattare le tasse? Come un conto debiti correnti o come una uscita?



R: Questa è una bella domanda; dovresti consultare il tuo commercialista. Il modo in cui trattare le tasse dipende fortemente dalla loro tipologia e da come tu vuoi trattarle... In alcuni casi sono spese, in altri sono debiti.


Capitolo 17. Bilanci



Questo capitolo spiega come creare e gestire i bilanci con GnuCash.
Concetti base



Il bilancio è uno strumento che permette di stimare e prevedere le entrate e le uscite. Si può utilizzare per aiutarsi nella pianificazione delle proprie finanze in un certo periodo di tempo e per esaminare come sono le proprie transazioni finanziarie attuali in confronto a quelle attese.
Il concetto di bilancio è generale e quindi GnuCash offre uno strumento di calcolo del bilancio che è semplice e flessibile. L’utente ha la libertà di decidere la complessità o la semplicità del proprio bilancio. Questa guida aiuterà nella scelta di queste decisioni.
Terminologia



Esistono dei termini utili che verranno utilizzati per trattare l’argomento del bilancio:
	Bilancio - un piano finanziario che descrive i redditi attesi e/o le spese relative ad un particolare periodo di tempo period

	Bilancio dei liquidi - un bilancio preventivo per gli introiti e gli esborsi di liquidi. Questio tipo di bilanciosi occupa dei flussi di liquidi: da dove proviene il proprio denaro, qual’è la sua destinazione e, naturalmente, a quanto ammonta.

	Bilancio delle uscite - un bilancio destinato principalmente alla pianificazione delle destinazioni del proprio denaro. Questo tipo di bilancio registra le proprie uscite. Generalmente non ha niente a che vedere con le rivalutazioni o con i rimborsi delle passività. Comunque, tiene conto degli interessi. Per esempio, se si acquistano €100 di alimentari con la carta di credito, si incorre in una spesa di €100 per alimentari e una passività di 100€ verso la compagnia della carta di credito. Quando si pagherà la ricevuta della carta di credito, verrà applicato un tasso di interesse che si suppone dia origine ad una spesa addizionale di €10. Un bilancio delle uscite è in grado di pianificare la transazione per l’acquisto degli alimentari e per il pagamento degli interessi, ma non la transazione per ripagare la compagnia della carta di credito.

	Bilancio di capitale - un bilancio che descrive un piano per pagare una ingente spesa futura, spesso attraverso una combinazione di risparmi e prestiti in denaro. Nota: i bilanci di capitale possono a volte divenire piuttosto complessi perché hanno anche lo scopo di rispondere alla domanda «è possibile permettersi di fare questo e quello?» esplorando diversi scenari che coinvolgono conti ipotetici.

	Periodo di bilancio - il periodo di tempo durante il quale il piano si sviluppa. I periodi di bilancio più comunemente utilizzati sono l’anno e il mese. Alle volte, potrebbe essere utile fare il bilancio per diversi periodi consecutivi in una volta, per convenienza o per una pianificazione più dettagliata. Ad esempio, un bilancio annuale può includere un periodo di bilancio di 12 mensilità.






Tassazione



Le politiche di tassazione variano considerevolmente fra un paese e un altro, quindi è virtualmente impossibile pronunciarsi in modo valido universalmente. Comunque, è possibile affermare che comunemente le entrate generate dai guadagni in conto capitale non sono soggette a tassazione fino al momento in cui il bene viene venduto e a volte nemmeno in questo momento. I proprietari di case nel Nord America, normalmente si ritrovano a non dover pagare nessuna tassa per il guadagno in capitale che ottengono dalla vendita. Altri paesi invece trattano la vendita delle case in modo differente: le autorità tedesche, per esempio, tassano i guadagni in capitale derivanti dalla vendita di una casa, solamente se si è stati proprietari per meno di dieci anni.
Chris Browne ha una storia da raccontare relativa a quando era un professionista della preparazione delle tasse; una famiglia che aveva venduto una fattoria, si aspettava una considerevole somma di tasse da pagare che però in realtà, furono quasi nulle per il fatto che avevano ottenuto la proprietà prima del 1971 (in cui è stabilita una data critica per le valutazioni in Canada) e dato che la fattoria era anche un caseificio per cui erano possibili alcune particolari deduzioni. La morale di questa storia è che mentre qui è stato mostrato in modo semplice, la tassazione può divenire molto complicata...

2. VERBATIM COPYING



You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions in section 3.
You may also lend copies, under the same conditions stated above, and you may publicly display copies.

Riconciliare gli estratti conto in valuta estera (come fare)



La riconciliazione degli estratti conto in valuta estera, avviene con le stesse modalità attraverso le quali si opera la riconciliazione del proprio conto bancario in valuta locale. Se è stata creata una struttura dei conti che permette di avere la stessa valuta dell’estratto conto anche per il conto, allora il procedimento è esattamente lo stesso della riconciliazione del proprio conto bancario in valuta locale a parte il fatto che potrebbe essere utile un dizionario (!).
Se si hanno diverse valute, si dovranno convertire manualmente gli importi tra una valuta e l’altra, mentre si riconciliano i conti.

Appendice E. Documentazione sulla licenza libera GNU (in inglese)

Versione 1.1, Marzo 2000

Diritto d'autore © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA02111-1307USA

 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.




0. PREAMBLE



The purpose of this License is to make a manual, textbook, or other written document «free» in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.
This License is a kind of «copyleft», which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.
We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.


Riconciliazione con il resoconto del prestito (come fare)



La riconciliazione con il resoconto del prestito avviene allo stesso modo della riconciliazione di un conto bancario con l’estratto conto.
Durante tutto il periodo dovrebbero essere state registrate tutte le transazioni relative al prestito per l’auto e ognuna di esse dovrebbe aver interessato il conto Passività:Prestiti:Prestito. In pratica, il pagamento di una rata del prestito, diminuisce il saldo del conto bancario e aumenta il saldo del conto del prestito, del conto degli interessi del prestito ed eventualmente del conto delle imposte amministrative sul prestito.
Avendo sott’occhio il resoconto cartaceo del prestito, aprire il conto del prestito, avviare la procedura di riconciliazione e spuntare tutte le transazioni registrate. Al termine di questa operazione, la differenza di riconciliazione deve essere pari a 0 e, se non lo è, controllare che tutte le transazioni presenti nel resoconto cartaceo siano riportate anche in GnuCash ed eventualmente individuare le differenze. Quando finalmente la differenza è nulla, il conto è riconciliato ed è possibile terminare la riconciliazione.
Per avere maggiori informazioni sul processo di riconciliazione, consultare la la sezione chiamata «Riconciliazione»

Registrare la propria impresa



After you have built the account structure and defined your tax tables, register the GnuCash
      file as belonging to your company. To register your company, select the Business tab
      in the Book Options window accessible by selecting 
      File → Properties.
      
Figura 13.3. Registrare la propria impresa
[image: Registrare la propria impresa]




Here you can:
	Inserire il nome della società e le informazioni di contatto quali il numero di telefono, di fax, l’indirizzo e-mail e l’indirizzo internet.

	Inserire l’identificativo della propria impresa per il pagamento delle tasse nel campo ID impresa.

	Selezionare la tabella imposte predefinita applicabile ai clienti e ai venditori più comuni.




Organizazzione dei file QIF (Discussione)




  

Appendice B. Domande poste frequentemente (FAQ)



Questo è un elenco delle domande poste nelle liste di discussione e per le quali non esiste una sezione apposita nella documentazione.
Fonti di Informazione



D: Dov’è la FAQ?



R: La stai leggendo! La versione più aggiornata è all’interno della Wiki di GnuCash.

D: Ci sono delle liste di discussione dedicate a GnuCash?



R: Sì! qui: http://lists.gnucash.org/mailman/listinfo/gnucash-user e http://lists.gnucash.org/mailman/listinfo/gnucash-devel per iscriverti.

D: esiste la possibilità di cercare un argomento nell’archivio delle liste di discussione?



R: Sì, recati qui http://news.gmane.org/gmane.comp.gnome.apps.gnucash.devel e qui http://news.gmane.org/gmane.comp.gnome.apps.gnucash.user (anche qui http://news.gmane.org/gmane.comp.gnome.apps.gnucash.german se conosci il Tedesco).

D: Esistono altri mezzi per ottenere aiuto riguardo GnuCash?



R: Sì. La maggior parte dei programmatori si ritrovano su ICQ nella discussione #gnucash su irc.gnome.org. È anche disponibile un wiki qui: http://wiki.gnucash.org/wiki/GnuCash.



Transazioni pianificate



Le transazioni pianificate sono utili per assistere nell’immissione di operazioni ripetitive con il denaro quali sottoscrizioni, assicurazioni e tasse. Utilizzando le transazioni pianificate, basta inserire la transazione in oggetto una sola volta, impostare alcuni parametri come la data di inizio, la frequenza e una breve descrizione, e poi GnuCash avvertirà ogniqualvolta sarà pronto a creare una nuova transazione oppure la creerà automaticamente.
In questa guida pratica, si considererà una sottoscrizione mensile al servizio internet di 20 Euro che viene pagata il 28 di ogni mese.
In GnuCash, si possono creare delle transazioni pianificate in due modi: dal libro mastro o dall’Editor transazioni pianificate.
Creazione dal libro mastro



Inserire nel registro la prima occorrenza della propria transazione da pianificare. Nel campo Trasferimento per questa transazione, digitare Uscite:Internet come mostrato nell’immagine seguente.
[image: Passo 1: creazione della transazione pianificata dal libro mastro]Passo 1: creazione della transazione pianificata dal libro mastro



Nota
Dato che non è ancora stato creato il conto Uscite:Internet, GnuCash ne richiederà la creazione.

Fare clic poi con il tasto destro sulla transazione e selezionare Pianifica...
[image: Passo 2: creazione della transazione pianificata dal libro mastro]Passo 2: creazione della transazione pianificata dal libro mastro



Verrà visualizzata una finestra come questa:
[image: Passo 3: creazione della transazione pianificata dal libro mastro]Passo 3: creazione della transazione pianificata dal libro mastro



Si compilino i valori richiesti; la sottoscrizione è prelevata il 28 di ogni mese e la successiva sarà per il mese prossimo (dato che quella per questo mese è stata inserita manualmente):
[image: Inserimento dei dati nella transazione pianificata]Inserimento dei dati nella transazione pianificata



Premere il pulsante OK e la transazione verrà pianificata. GnuCash ha ora memorizzato la transazione pianificata e, il 28 del mese prossimo, presenterà una finestra in cui verrà richiesto se la transazione deve essere creata (un’immagine di questa finestra è riportata qui sotto).

Creazione dalla finestra dell’Editor transazioni pianificate



Un altro modo per inserire una transazione pianificata è dalla finestra dell’Editor transazioni pianificate; questo metodo può essere più veloce se si devono creare più transazioni in una sola volta.
Dalla finestra principale dei conti selezionare Operazioni → Transazioni pianificate → Editor transazioni pianificate sulla barra del menu. Verrà così aperta una nuova scheda denominata Transazioni pianificate come quella riportata di seguito:
[image: Scheda Transazioni pianificate vuota]Scheda Transazioni pianificate vuota



Questa scheda contiene un elenco, per ora vuoto, di tutte le transazioni pianificate. Crearne una nuova premendo il pulsante Nuovo sulla barra degli strumenti; si aprirà una nuova finestra come questa:
[image: Editor transazioni pianificate — scheda In generale]Editor transazioni pianificate — scheda Generali



Inserire dapprima un nome per la nuova transazione pianificata nell’apposito campo nella parte superiore della finestra.
Nota
Il nome identifica la transazione solamente nell’Editor transazioni pianificate, non apparirà mai nel registro.

Nel riquadro Opzioni della scheda Generali sono disponibili quattro opzioni:
	Attiva
	Imposta lo stato della transazione pianificata.

	Crea automaticamente
	Se abilitata, la transazione verrà inserita nel libro mastro senza che venga richiesta alcuna conferma (vedere nel seguito). Se necessario, è possibile essere avvisati al momento dell’inserimento della transazione abilitando l’opzione Notifica quando creata.

	Crea in anticipo di
	Imposta il tempo in anticipio con cui la transazione pianificata verrà creata.

	Ricorda in anticipo di
	Imposta l’anticipo con cui notificare la scadenza della transazione. È utile, per esempio, quando si deve pagare con un assegno; GnuCash può ricordare l’incombenza una settimana prima così da poter inviare l’assegno prima della scadenza.



Il riquadro Scadenze permette di dire a GnuCash che questa transazione non durerà per sempre; per esempio se si sta ripagando un prestito, si può selezionare la data di termine del prestito o il numero di rate rimanenti.
Selezionare poi la scheda della Frequenza nell’Editor transazioni pianificate. Qui è possibile impostare le opzioni relative al tempo per la transazione.
[image: Editor transazioni pianificate — scheda Frequenza]Editor transazioni pianificate — scheda Frequenza



	Frequenza
	Imposta la frequenza di base della transazione; selezionare un valore tra una volta,quotidiana,settimanale,quindicinale e mensile. In questo esempio verrà impostata a mensile
Nota
È possibile impostare delle scadenze a intervalli diversi da quelli elencati nell’elenco delle Frequenze, modificando le impostazioni della voce Ogni (vedere nel seguito).


	Data d’inizio
	Imposta l’inizio della transazione. Nell’esempio, questa sarà l’inizio del mese prossimo.

	Ogni
	Questa opzione permette di pianificare letransazioni in periodi multipli del valore impostato come Frequenza. Per esempio, per creare una transazione pianificata ogni 3 settimane, impostare la Frequenza a settimanale e il campo Ogni a 3.

	Poi il e a eccezione dei fine settimana
	Imposta il giorno del mese in cui è pianificata la transazione e controlla il comportamento di GnuCash quando la scadenza coincide con un giorno del fine settimana.



Nota
La sottoscrizione è prelevata il 28 di ogni mese, quindi la Data d’inizio sarà il 1° Novembre 2003 (assumendo che Novembre sia il mese prossimo) e la Frequenza sarà mensile; verrà quindi prelevata il 28 di ogni mese. Dato che nell’esempio l’abbonamento internet viene prelevato automaticamente dal conto, non sarà necessario né creare la transazione in anticipo né impostare una data finale.

Quando le voci di questa scheda sono state completate, GnuCash evidenzierà le scadenze future nel calendario sulla parte inferiore della finestra.
Infine, selezionare la scheda del Modello di transazione e inserire la transazione nella parte bassa come si farebbe nel libro mastro, con la sola differenza che non è richiesta una data.
Ora, si dovrebbe avere una finestra come questa:
[image: Editor transazioni pianificate — scheda Modello di transazione]Editor transazioni pianificate — scheda Modello di transazione



Si ricordi di premere il pulsante Inserisci, per convalidare e immettere la transazione.
Premendo Ok, si tornerà alla scheda delle Transazioni pianificate, ora con un elemento nella lista delle Transazioni:
[image: Transazione pianificata inserita]Transazione pianificata inserita



Suggerimento
Facendo clic nel calendario in corrispondenza del primo giorno del mese, una piccola finestra, che seguirà il mouse, mostrerà ciò che è pianificato in quel giorno. Per far scomparire la finestra è sufficiente fare clic su di essa una volta.

Ora è possibile chiudere la scheda Transazioni pianificate e salvare il proprio lavoro.
Nota
Quello mostrato di seguito è solo a titolo esemplificativo e non deve essere immesso nel file di GnuCash in questa fase. Avendo questo esempio come base, la finestra più sotto apparirà quando la transazione pianificata è impostata per essere inserita.

D’ora in poi, quando si avvia GnuCash e se è in scadenza o se deve essere inserita una transazione pianificata, potrebbe essere visualizzata la finestra Dall’ultimo avvio che riassume le operazioni pendenti relative alle transazioni pianificate (Promemoria, Da creare ecc... una descrizione di ogni opzioni è fornita nel manuale di GnuCash):
[image: Finestra di promemoria per la transazione pianificata]Finestra di promemoria per la transazione pianificata



È possibile fare clic nella colonna Stato per modificare lo stato della transazione pianificata, se necessario. Fare poi clic sul pulsante Ok per chiudere la finestra Dall’ultimo avvio... e applicare le eventuali modifiche. Selezionare Annulla per scartare le operazioni impostate.
Se il campo Stato era già (o è stato impostato) a Da creare, se si controlla nel registro del conto bancario, si noterà che la transazione è stata creata:
Suggerimento
Abilitando l’opzione Controlla le transazioni create nella parte inferiore destra della finestra Dall’ultimo avvio..., GnuCash aprirà, dopo aver premuto il pulsante Ok, la scheda del registro di ogni conto in cui sono state inserite automaticamente le transazioni pianificate.

Nota
Se la transazione per il 28 Aprile è stata inserita in questa fase, ritornare all’ultimo file salvato di GnuCash. Andare in File → Apri e selezionare gcashdata_3



